
For safe and correct use of this machine, 
please be sure to read the Safety Information 
in this manual before you use it.



About the Operating Instructions

Your machine comes with the two References:

Copy/Printer/Scanner Reference provides information you need for setting up your 
machine and installing the supplied software. It also provides all of the detailed instructions for 
using your machine as a printer, a scanner and a copier and information for maintaining and 
troubleshooting the machine.

Facsimile Reference provides information for using your machine as a fax machine. You can 
find how to send and receive a fax, and how to set fax-related options.

Contents of this manual are subject to change without prior notice. In no event will the 
company be liable for direct, indirect, incidental or consequential damages as a result of 
handling or operating the machine.

Copyright © 2004

• Centronics is a trademark of Centronics Data Computer Corporation.

• IBM and IBM PC are trademarks of International Business Machines Corporation.

• Microsoft, Windows, Windows 9x, Window Me, Windows 2000, Windows NT 4.0 
and Windows XP are registered trademarks of Microsoft Corporation.

• All other brand or product names are trademarks of their respective companies or 
organizations.



Safety Information

When using this machine, the following safety precautions should always be followed.

Safety During Operation
In this manual, the following important symbols are used: 

 WARNING:

 WARNING:

Indicates a potentially hazardous situation which, if instructions are 
not followed, could result in death or serious injury.

 CAUTION:
Indicates a potentially hazardous situation which, if instructions are not 
followed, may result in minor or moderate injury or damage to property.

• Connect the power cord directly into a wall outlet and never use an 
extension cord.

• Disconnect the power plug (by pulling the plug, not the cable) if the power 
cable or plug becomes frayed or otherwise damaged.

• To avoid hazardous electric shock or laser radiation exposure, do not 
remove any covers or screws other than those specified in this manual.

• Turn off the power and disconnect the power plug (by pulling the plug, not 
the cable) if any of the following occurs:

•You spill something into the machine.

•You suspect that your machine needs service or repair.

•The external housing of your machine has been damaged.

• Do not incinerate spilled toner or used toner. Toner dust might ignite when 
exposed to an open flame.

• Disposal can take place at our authorized dealer.

•Dispose of the used toner bottle in accordance with the local 
regulations.
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 CAUTION:

Power Supply

The socket-outlet shall be in stalled near the product and shall be easily accessible.

Ozone Safety (if applicable)

Some product (see specification in the Operating Instructions) generates ozone during 
operation.
Normally, the ozone level is safe for operators. If ozone odor may appear, ventilate the room.

For Fax or Telephone

Do not use this product near water, for example, near a bathtub, wash bowl, kitchen sink or 
laundry tub, in a wet basement or near a swimming pool. Avoid using a telephone during an 
electrical storm. There may be a remote risk of electric shock from lightning. Do not use a 
telephone in the vicinity of a gas leak to report the leak.

For North America
CDRH Regulations
This equipment complies with requirements of 21 CFR subchapter J for class 1 laser products. 
This equipment contains a 5 milliwatt, 760–800 nanometer wavelength, AlGaAs laser diode. 
This equipment does not emit hazardous radiation, since the beam is totally enclosed during 
all customer modes of operation and maintenance.

Caution:

Use of controls or adjustment or performance of procedures other than those specified in this 
manual might result in hazardous radiation exposure.

• Protect the machine from dampness or wet weather, such as rain and snow.
• Unplug the power cord from the wall outlet before you move the machine. While 

moving the machine, you should take care that the power cord will not be damaged 
under the machine.

• When you disconnect the power plug from the wall outlet, always pull the plug (not 
the cable).

• Do not allow paper clips, staples, or other small metallic objects to fall inside the 
machine.

• Keep toner (used or unused) and toner bottle out of the reach of children.
• Be careful not to cut yourself on any sharp edges when you reach inside the product 

to remove misfed sheets of paper or masters.
• For environmental reasons, do not dispose of the machine or expended supply 

waste at household waste collection points. Disposal can take place at an authorized 
dealer.

• The inside of the machine could be very hot. Do not touch the parts with a label 
indicating the “hot surface”. Otherwise, an injury might occur.



Positions of Labels and Hallmarks for 
WARNING and CAUTION Labels

This machine has labels for WARNING and CAUTION at the positions shown below. For 
safety, please follow the instructions and handle  the machine as indicated.

In accordance with IEC 60417, this machine uses the following symbols for the main power 
switch: 

 means POWER ON.

 means POWER OFF.

 

The inside of the machine could be very hot.
Do not touch the parts with a label indicating the "hot surface".
Otherwise it could cause a personal burn.
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NOTICE

Note to users in the United States of America

Notice:

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commereial 
environment. This equipment generates, uses and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will be required to correct the interference 
at his own expence.

 Warning
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

Notice about the Telephone Consumer Protection Act (Valid in USA 
only).
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use 
a computer or other electronic device, including FAX machines, to send any message 
unless such message clearly contains in a margin at the top or bottom of each 
transmitted page or on the first page of the transmission, the date and time it is sent 
and an identification of the business or other entity, or other individual sending the 
message and the telephone number of the sending machine or such business, other 
entity, or individual. (The telephone number provided may not be a 900 number or any 
other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your FAX machine, you should complete the 
following steps: Follow the FAX HEADER programming procedure in the Programming 
chapter of the operating instructions to enter the business identification and telephone 
number of the terminal or business. This information is transmitted with your document 
by the FAX HEADER feature. In addition to the information, be sure to program the date 
and time into your machine.
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USA

  FCC Requirements

1. This equipment complies with Part 68 of the FCC rules and requirements adopted 
by the ACTA. On the cover of this equipment is a label that contains, among other 
information, a product identifier in the format US:AAAEQ##TXXXXX. If requested, 
this number must be provided to the telephone company.

2. This equipment uses the RJ11C USOC jack.

3. A plug and jack used to connect this equipment to the premises wiring and 
telephone network must comply with the applicable FCC Part 68 rules and 
requirements adopted by the ACTA. A compliant telephone cord and modular plug 
is provided with this product. It is designed to be connected to a compatible 
modular jack that is also compliant. See installation instructions for detail.

4. The REN is used to determine the number of devices that may be connected to a 
telephone line. Excessive RENs on a telephone line may result in the devices not 
ringing in response to an incoming call. In most but not all areas, the sum of RENs 
should not exceed five (5.0). To be certain of the number of devices that may be 
connected to a line, as determined by the total RENs, contact the local telephone 
company. The REN for this product is part of the product identifier that has the 
format US:AAAEQ##TXXXXX. The digits represented by ## are the REN without a 
decimal point (e.g., 03 is a REN of 0.3).

5. If this equipment causes harm to the telephone network, the telephone company 
will notify you in advance that temporary discontinuance of service may be 
required. But if advance notice is not practical, the telephone company will notify 
the customer as soon as possible. Also, you will be advised of your right to file a 
complaint with the FCC if you believe it is necessary.

6. The telephone company may make changes in its facilities, equipment, operations 
or procedures that could affect the operation of the equipment. If this happens the 
telephone company will provide advance notice in order for you to make necessary 
modifications to maintain uninterrupted service.

7. If trouble is experienced with this equipment, for repair or warranty information, 
please contact RICOH CORP. CUSTOMER SUPPORT DEPT. at 1-800-FASTFIX. If the 
equipment is causing harm to the telephone network, the telephone company may 
request that you disconnect the equipment until the problem is resolved.

8. In the event of operation problems (document jam, copy jam, communication error 
indication), refer to the solving problems section in this manual.

9. Connection to party line service is subject to state tariffs. Contact the state public 
utility commission, public service commission or corporation commission for 
information.

 WHEN PROGRAMMING EMERGENCY NUMBERS AND/OR MAKING TEST CALLS TO 
EMERGENCY NUMBERS:

1. Remain on the line and briefly explain to the dispatcher the reason for the call before 
hanging up.

2. Perform such activities in the off-peak hours, such as early morning hours or late 
evenings.
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CANADA

The Ringer Equivalence Number is an indication of the maximum number of devices allowed to 
be connected to a telephone interface. The termination on an interface may consist of any 
combination of devices subject only to the requirement that the sum of the RENs of all the 
devices does not exceed five.

This product meets the applicable Industry Canada technical specifications.

Note:

This Class A digital apparatus complies with Canadian ICES-003.
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1
 GETTING STARTED
Thank you for purchasing multifunctional product. This 
machine provides printing, copying, scanning, and 
faxing functions!

This chapter provides step-by-step instructions on 
setting up the machine, and installing the software.

This chapter includes:

• Unpacking

• Component Location

• Control Panel Functions

• Making Connections

• Installing the Drum and Toner Cartridges

• Turning the Machine On

• Loading Paper

• Tray Setting the Paper Size

• Changing the Display Language

• Using Save Modes



Unpacking

1 Remove the shipping tape from the front, back, and sides of 
the machine.

2 Remove the label completely from the scanner module by 
pulling it straight out, away from the unit. The scan unlock 
switch automatically moves to the unlock position ( ).

NOTE: To scan or copy a document, the 
switch must be on that position. When you 
are moving the machine or do not intend to 
use it for a long time, push the switch to the 
lock position ( ).

3 Pull open the paper Tray and remove the packing material 
from the paper Tray.

Tape

Scanner 
module
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GETTING STARTED 1.3

4 Ensure that you have the following:

USB Cable AC Power Cord

Telephone Line Cord Quick install Guide

Quick Guide CD-ROM*

*. The CD-ROM contains the Type 102 driver, Operating Instructions and the 
Adobe Acrobat Reader program.

Toner Cartridge

Brand  plaque**

Key layout sheet***

**. May already be affixed to the machine in some regions.
***. May already be affixed to the machine .

Drum Cartridge

One-Touch sheet***



Component Location

Take a moment to familiarise yourself with the main components 
of your machine.

Front View

Automatic 
Document Feeder

Document 
Guides

Document 
Input Tray

Document 
Output Tray

Control Panel

Paper Tray

Front Cover

Release lever

Side Cover

Paper Guides

Scanner Module

Bypass Tray 
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Rear View

Paper Exit Extension

ADF (Automatic Document 
Feeder) Connector

Document Cover

Paper Tray

Document 
Glass

AC Power Cord
Connector

Parallel Connector

USB 
Connector

Power Switch

Telephone
Connections
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Control Panel Functions

System Data System ID Date & Time System Setup Memory Clear

Facsimile
Resolution

Receive Mode

Search/Delete

Speed/Status

Redial/Pause

Flash/Recall/R

Copy

Facimile Copy

Contrast On Hook Dial

Clear/Stop

Start

Image

Symbols

Paper Tray

Special Copy

Duplex Copy

Paper Save
Menu/Exit

Increase

Zoom Set

Decrease

Mode/Enter

Delay TX Memory TX Priority TX Polling Add/Cancel

Group Dial Maintenance Tx Confirm Scgedule Job

Phone Book System List Rx JournalTx Jornal Help List

4

8 1110

12

2 71

9

3 5 6

1

Used to store frequently dialled fax numbers 
and dial them with the touch of one button. Also 
use in conjunction with the Menu/Exit button 
to access the corresponding menu function.

Allows you to              one-touch buttons to the 
locations 21 through 40.

2

F
a
c
s
i

m
i
l
e

Adjusts the resolution of the current fax job 
documents.

Used to choose the receive mode. The selected 
mode is displayed in Standby mode.

Used to search for a number in the memory. 
Also used to delete digits in editing mode.

Used to store frequently dialed fax numbers and 
dial them using the associated 2-digit speed dial 
number. Also used to alternately display 
alternately the currently active job and any 
pending jobs.

Redials the last number in Standby mode or 
inserts a pause into a fax number in the edit 
mode.

Used to perform a hook-switch operation, such 
as call waiting.

System Data System ID Date & Time System Setup Memory Clear

Delay TX Memory TX Priority TX Polling

Group Dial

Add/Cancel

Maintenance Schedule JobTx Confirm

System ListPhone Book Tx Journal Rx Journal Help List

Resolution

Receive Mode

Search/Delete

Speed/Status

Redial/Pause

Flash/Recall/R
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3

(status map)

When an error occurs, the lamp on the 
corresponding location on the Status map turns 
on, as well as the error indicator, and the error 
message appears on the display so that you can 
locate the error. For details on the meaning of 
the error messages, see page 8.11.

 (Error 
   indicators)

Turns on when a paper jam occurs. To clear 
the jam, see page 8.4.

Turns on when the toner or drum has 
almost run out. To replace the toner or 
drum cartridge, see page 7.3 and page 7.8.

Turns on when the input tray you are using 
is empty. To load paper, see page 1.15.

Turns on when an error occurs on the 
system.

4 Displays the current status and prompts during 
operation. 

5

C
o
p
y

Used to adjust the contrast of the current copy 
or fax job.

Used to select the text type for the current copy 
job or fax job.

Used to specify the paper tray you want to use 
in Fax or Copy mode.

Used to set up special copy features, such as 
AutoFit, Clone, and Collation.

The current copy job will use both sides of the 
paper when printed.

Allows you to save paper by printing 2 pages on 
a single sheet of paper (available in the Copy 
mode only).

ex) The paper is jammed in the exit area.

Contrast

Image

Paper Tray

Special Copy

Duplex Copy

Paper Save
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* Navigation buttons

6 Used to dial a number or enter alphanumeric 
characters.

7 Engages the telephone line.

8
Enters the menu functions in conjunction with 
the one-touch buttons. Also backs you up to the 
previous menu level or exits the menu.

9*

Scrolls though the menu items. When you set 
the copy size or the copy page number, they can 
be used to change the number.

Scrolls though the options available for the 
selected menu item. In the Copy mode,  
allows you to change the zoom rate and  to 
change the number of copies.

10 Selects the mode to activate: FAX or COPY. Also, 
confirms the selection on the display.

11 Used to start a job.

12

Used to stop an operation at any time.
Also, used to clear/cancel the copy options such 
as the zoom rate and multi copy pages in Copy 
mode. 

On Hook Dial

Menu/Exit

Increase

Decrease

Facimile Copy
Mode/Enter

Start

Clear/Stop
GETTING STARTED1.8



1

Making Connections

1 Connect the ADF (Automatic Document Feeder) cord to this 
port and fasten the side screws.

NOTE: Without connecting the cord to the port, you cannot use 
the ADF.

2 Connect the telephone line to the LINE jack and the other 
end to the wall jack.

If you want to use your machine for receiving both faxes 
and voice calls, you will need to connect a telephone and/or 
answering machine to your machine. 
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Plug the cord of your extension phone or answering 
machine into the EXT jack.

NOTE: You should use the telephone line cord which is supplied 
with your machine. If you are replacing it with another vendor’s, it 
should be AWG #26 or lower gage.

3 Connect the USB cable which came with your machine.
GETTING STARTED1.10
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If you want to use a parallel printer cable, only use a IEEE 
1284 compliant cable and connect it to the parallel 
connector on your machine.

NOTE:
• To connect the machine to the parallel port of the computer 

requires a certified parallel cable.
You will need to buy the a IEEE 1284 compliant cable.

• You only need to connect one of the above cables.

• If you are using a USB cable, you must be running Windows 98/
Me/2000/XP. 

• When using the a USB connection, your machine provides two 
USB modes; Fast and Slow. Fast is the default mode. Some PC 
user may experience poor USB function in the default mode. If 
this occurs, select the Slow mode to achieve successful results. 
For details on changing the USB mode, see page 8.16.
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Installing the Drum and Toner 
Cartridges

1 Pull the release lever to open the side cover.

NOTE: Ensure that the side cover is always open before opening 
the front cover.

2 Open the front cover.

3 If the cartridge locking lever is on the lower position, turn 
the lever upward until it locks into place.
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4 Remove the drum cartridge from its bag and slide it into the 
machine firmly until it locks into place completely.

5 Remove the starter toner cartridge from its bag. Gently 
shake the cartridge to loosen the toner.

Thoroughly shaking the cartridge will assure maximum 
copies per cartridge.

6 Slide the toner cartridge into the machine aligning the 
cartridge to the left of the slot until it locks into place 
completely.
GETTING STARTED 1.13



7 Turn the cartridge locking lever downwards until it locks into 
place.

8 Close the front cover  and then side cover .

NOTE: When the drum or toner cartridge need to be replaced, the 
display indicates the corresponding message with the error 
indicator. Refer to the list of error messages on page 8.11. 

To replace the drum and toner cartridges, see page 7.8 and 
page 7.3 respectively.

1 2

1

2
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Turning the Machine On 

1 Plug one end of the supplied three-wire electrical grounding 
type cord into the AC socket on the machine and the other 
end into a properly grounded AC outlet. 

2 Turn on the power switch. “WARMING UP PLEASE WAIT” 
appears on the display indicating that the machine now is 
on. 

To view your display text in another language, see 
page 1.19.

CAUTION: Power cord must be plugged into a grounded power 
socket.

Loading Paper

The paper Tray can hold a maximum of 550 sheets of 20lb plain 
paper. For copying or faxing, you can use A4-, letter-, or legal-
size paper only.
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1 Pull open the paper Tray.

2 Push down on the pressure plate until it locks in position.

3 Adjust the rear paper guide to the desired paper length. It 
is preset to Letter or A4 size depending on the country. To 
load another size, lift and insert the rear guide into the 
corresponding position. 

Rear guide

LGL

FOLIO

A4
LTR
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4 Fan the paper and insert it into the Tray.

5 Ensure that the paper corners are under the corner 
snubbers.

Do not fill above the max fill line.

Corner
snubber

Max Fill Line
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6 While pinching the side guide as shown, move it toward the 
stack of paper until it lightly touches the side of the stack. 
Do not press the guide too tightly to the edge of the paper; 
the guide may bend the paper.

7 Close the paper Tray.
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Tray Setting the Paper Size

After loading paper in the paper Tray, you need to set the paper 
size using the control panel buttons. These settings will apply to 
the Copy mode only. In the PC printing mode, you have to select 
the paper size in the application program you use.

1 Press Menu/Exit and then System Data from the one-
touch dial keypad. 

The display shows “CASSETTE PAPER” on the top line and 
the available options on the bottom line.

2 Use  or  to find the paper size you are using, and press 
Mode/Enter to save the selection. 

You can press the corresponding number shown on the 
display to select the paper size.

3 To return to Standby mode, press Clear/Stop.

Changing the Display Language

To change the language that is displayed on the LCD display, 
take the following steps:

1 Press Menu/Exit and then System Setup from the one-
touch dial keypad. 

2 Press  or  until “SELECT LANGUAGE” appears on the top 
line of the display. The current setting appears on the 
bottom line of the display.

3 Press  or  until you see the language you want on the 
display.

4 Press Mode/Enter to save the selection. 

5 To return to Standby mode, press Clear/Stop.



Using Save Modes

Paper Save

This feature prints 2 pages on a single sheet to save paper. To 
turn this feature on, take the following steps:

1 Press Paper Save. The display shows the current setting 
on the bottom line.

2 Press Paper Save or use the navigation buttons to change 
the setting. To enable the Paper Save mode, select “ON.” Or 
select “OFF” to disable the mode.

3 Press Mode/Enter to save the selection.

NOTES: 
• The Paper Save mode is available only when the document is 

loaded in the ADF.

• The Paper Save mode is disabled when you set the collation or 
duplex copy options. 

Power Save

The Power Save mode allows the printer to reduce power 
consumption when it is not in actual use.

You can select the length of time the machine waits after a job 
is printed before it switches to a reduced power state.

1 Press Menu/Exit and then System Data from the one-
touch dial keypad. 

2 Press  or  until “POWER SAVE” appears on the display. 
Make sure that “ON” blinks on the bottom line. 

If necessary, use  or  to select “ON” and press Mode/
Enter. 

3 The available time settings appear on the display and the 
current setting blinks. The available options are 5, 10, 15, 30, 
and 45 (minutes). Press  or  until the desired time blinks. 

4 Press Mode/Enter to save the selection. 

5 To return to Standby mode, press Clear/Stop.
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2
 INSTALLING SOFTWARE
This chapter provides information about installing the 
supplied software.

The topics included in this chapter are:

• About the Software

• System Requirements

• Installing the Software

• Removing Software



About the Software

You must install software using the supplied CD-ROM after you 
have set up your machine and connected it to your computer. 
The CD-ROM includes:
• Type 102 Software
• Operating Instructions
• Adobe Acrobat Reader

The CD-ROM provides you with the following software:

Type 102 Driver 

To use your machine as a printer and scanner in Windows, you 
must install the Type 102 driver. For information about installing 
the Type 102 driver in Windows, see page 2.4.

Remote Control Panel

It is automatically installed when you install the Type 102 driver. 
For information about using the program, refer to the Facsimile 
Refernce. 
INSTALLING SOFTWARE2.2
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System Requirements

Before you begin, ensure that your system meets the minimum 
requirements.

Supported Operating System

• Windows 95 OSR2

• Windows 98/Windows 98 SE

• Windows Me

• Windows NT 4 Workstation or Server with Service Pack 3

• Windows 2000 Professional or Advanced Server

• Windows XP Home edition or Professional.

Minimal Requirements

•  Disk space: 120 MB for installation 

•  Memory: 64 MB 

•  CPU: Pentium II 233 or higher

•  Required software: Internet Explorer 5.0

Recommended

•  Disk space: 220 MB for installation

•  Memory: 128 MB

•  CPU: Pentium II 400 or higher

•  Required software: Internet Explorer 5.5

NOTES: 

• For Windows NT 4.0/2000/XP, the system administrator should 
install the software.

• Windows 95 versions prior to OSR2 are not recommended due to 
incompatibility with OLE/COM libraries.
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Installing the Software

NOTES: 
• Cancel the “New Hardware Found” window when your computer 

boots up.

• Make sure that your machine is plugged in and connected to 
your computer’s parallel port or USB port before installing 
software. Windows 95 and Windows NT 4.0 do not support the 
USB connection.

1 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run and an maintenance 
window appears.

If the maintenance window does not appear, click Start 
and then Run. Type X:\Setup.exe, replacing “X” with the 
letter of your drive and click OK.

NOTE: If your machine is not connected to the computer, the 
following window will appear.

• After connecting the machine, click Next.

• If you want to skip the connection status, click Next, and No to 
the following screen. Then the installation will start and the test 
page will not be printed at the end of the installation.

• For details about installation problems, see p.2.6 "Removing  
Software", Copy/Printer/Scanner Reference." when you have 
some problems during installation.
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2 Choose the installation type. 

•Typical: Installs the common software for your printer, 
such as Printer driver, Twain driver, Remote Control Panel. 
This is recommeded for most users.

•Custom: Allows you to choose the language of the 
software and the components you want to install. After 
selecting the language and the component(s), click Next.

•View Operating Instructions: Allows you to view this 
Operating Instructions. If your computer doesn’t have 
Adobe Acrobat, click on this option and it will automatically 
install Adobe Acrobat for you.

3 After the installation is finished, the window asking you to 
print a test page appears. If you choose to print a test 
page, select the check box and click Next.

4 When the test page prints out correctly, click Yes.

If not, click No to reprint it.

5 Click Finish.



Removing Software

Uninstall is required if you are upgrading the software or if your 
installation fails. You can uninstall all software of this machine, 
using the CD-ROM or uninstall the desired item using the 
Windows unInstallShield.

1 You can select Start → Programs → Type 102 → 
Maintenance.

Otherwise, insert the supplied CD-ROM into your CD-ROM 
drive.

The CD-ROM should automatically run and an installation 
window appears.

If the Maintenance window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter of your drive and click OK.

2 Click Remove.

Then you will see a component list so that you can remove 
any of them individually.

If you want to uninstall the Printer driver, check Printer.

If you want to uninstall the Twain driver, check Twain. 

If you want to uninstall the Remote Control Panel, check 
Remote Control Panel.

3 After selecting items you wish to remove, click Next.

4 When your computer asks you to confirm your selection, 
click Yes.

The selected driver and all of its components are removed 
from your computer. 

5 When the uninstallation is done, click Finish. 
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 PAPER HANDLING
This chapter introduces you to the basics of selecting print 
media and loading print media into your machine.

This chapter includes:

• Selecting Print Media

• Paper Guidelines

• TrayLoading Paper in the Tray

• Using the Bypass Tray

• Setting the Paper Size for Copying



Selecting Print Media

Always use print media that meets the guidelines for use with 
this machine. Using a print media that is not recommended may 
cause paper jams or print quality problems.

Media Size Input Sources and Capacities 

Media Size
Input Source/Capacitya

a. Maximum capacity may be reduced depending on paper 
thickness.

Paper Tray Bypass Tray

Plain paper
Letter (8.5 x 11 in.) 
Folio (8.5 x 13 in.)
Legal (8.5 x 14 in.)
Executive (7.25 x 10.5 in.)
A4 (210 x 297 mm)
B5 (182 x 257 mm)
A5 (148 x 210 mm)

YES/550
YES/550
YES/550
NO/0
YES/550
NO/0
NO/0

YES/100
YES/100
YES/100
YES/100
YES/100
YES/100
YES/100

Envelopes
No. 10 (4.12 x 9.5 in.)  
C5 (162 x 229 mm)
DL (110 x 220 mm)
Monarch (3.87 x 7.5 in.)
B5 (176 x 250 mm)

NO/0
NO/0
NO/0
NO/0
NO/0

YES/10
YES/10
YES/10
YES/10
YES/10

Labelsb

Letter (8.5 x 11 in.)
A4 (210 x 297 mm)

b. If you are experiencing excessive jamming, feed one sheet at a 
time through the Bypass Tray.

NO/0
NO/0

YES/30
YES/30

Transparency filmsb

Letter (8.5 x 11 in.)
A4 (210 x 297 mm)

NO/0
NO/0

YES/30
YES/30

Card stocksb

A6 (105 x 148 mm)
Post Card (4 x 6 in.)
Hagaki (100 x 148 mm)

NO/0
NO/0
NO/0

YES/10
YES/10
YES/10
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Paper Guidelines

When selecting or loading paper, envelopes, or other special 
media, keep these guidelines in mind:

• Attempting to print on damp, curled, wrinkled, or torn paper 
can cause paper jams and poor print quality.

• Use only high quality copier grade paper. Avoid paper with 
embossed lettering, perforations, or texture that is too 
smooth or too rough.

• Store paper in its ream wrapper until ready to use. Place 
cartons on pallets or shelves, not on the floor. Do not place 
heavy objects on top of the paper, whether it is packaged or 
unpackaged. Keep it away from moisture, or other conditions 
that can cause it to wrinkle or curl.

• During storage, moisture-proof wrap (any plastic container or 
bag) should be used to prevent dust and moisture from 
contaminating your paper.

•  Always use paper and other media that conform with the 
specifications listed under “General Specifications” on 
page A.2.

• Use only well-constructed envelopes with sharp, well creased 
folds.
- DO NOT use envelopes with clasps and snaps.
- DO NOT use envelopes with windows, coated lining, 
 self-adhesive seals, or other synthetic materials.
- DO NOT use damaged or poorly made envelopes.

• It is recommended that you feed special paper types one 
sheet at a time.

• Only use the special media recommended for use in laser 
printers.

• To prevent special media such as transparencies and label 
sheets from sticking together, remove them from the exit tray 
as they are printed.

• Place transparencies on a flat surface after removing them 
from the machine.

• Do not leave the film in the paper tray for long periods of 
time. Dust and dirt may accumulate on them resulting in 
spotty printing.

• To avoid smudging caused by fingerprints, handle 
transparencies and coated paper carefully.

• To avoid fading, do not expose the printed transparencies to 
prolonged sunlight.
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• Store unused media at temperatures between 59oF and 86oF 
(15oC to 30oC). The relative humidity should be between 10% 
and 70%.

• Do not load more than 10 sheets of special media into the 
Bypass Tray at a time.

• Verify that your labels’ adhesive material can tolerate fusing 
temperature of 200oC (392oF) for 0.1 second.

• Make sure that there is no exposed adhesive material 
between labels. Exposed areas can cause labels to peel off 
during printing, which can cause paper jams. Exposed 
adhesive can also cause damage to machine components.

• Do not feed a sheet of labels through the machine more than 
once. The adhesive backing is designed for one pass through 
the machine.

• Do not use labels that are separating from the backing sheet 
or are wrinkled, bubbled, or otherwise damaged.

TrayLoading Paper in the Tray

The paper Tray can hold a maximum of 550 sheets of 20lb(75g) 
plain paper. For copying or faxing, you can use A4-, letter-, or 
legal-size paper only.

To load paper, pull open the paper Tray and place paper with the 
side you want to print facing up.
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You can load letterhead paper with the design side facing up. 
The top edge of the sheet with the logo should be placed at the 
right side.

For details on loading paper in the Tray, see page 1.15.

After loading paper in the Tray, you need to set the correct paper 
size using the control panel buttons. See page 1.19.

NOTES: 

• When you print a file from your PC using the paper Tray, make 
sure that you select the Paper source and the correct paper size 
from your software application before starting your print job.

• If you experience problem with the paper feed, place the paper 
in the Bypass Tray.

• You can load up to 300 sheets 
of previously printed paper. 
The printed side should be 
facing down with the uncurled 
edge at the right side. If you 
experience problems with the 
paper feed, turn the paper 
around. Note that the print 
quality is not guaranteed.
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Using the Bypass Tray

Bypass Tray is located at the right side of your machine. It can 
be closed when you are not using it, making the machine more 
compact.

Use the Bypass Tray to print transparencies, labels, envelopes 
or postcards in addition to making quick runs of paper types or 
sizes that are not currently loaded in the paper Tray.

Acceptable print media are plain paper with sizes ranging from 
98 x 148 mm (3.9 x 5.8 in.) to Legal 216 x 356 mm (8.5 x 14 
in.), the largest size acceptable, and weighing between 16lb and 
32lb.

The following table summarizes the print media allowed as well 
as their stacking height limit.

Notes: 

• Always load only use print media specified in Specifications to 
avoid paper jams and print quality problems.

• Do not hit the Bypass Tray or rest your hands on it; otherwise 
the tray may be damaged or detached from the machine.

• Flatten any curling on postcards, envelopes, and labels before 
loading them into the Bypass Tray.

Paper Type Stacking Height Limit

Plain Paper 100 sheets or 9mm (max)a

a. The height is measured with the stack of sheets untouched laid 
on a flat surface.

Envelope 10 envelopes or 9mm (max)a

Transparency 30 sheets or 9mm (max)a

Label 30 sheets or 9mm (max)a

Cardstock 10 sheets or 9mm (max)a
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To load print media in the Bypass Tray:

1 Lower the Bypass Tray, located on the right side of the 
machine. Unfold the paper support extension as shown.

2 Prepare a stack of paper or envelopes for loading by flexing 
or fanning them back and forth. Straighten the edges on a 
level surface.

For transparencies, hold the transparencies by the edges 
and avoid touching the print side. Oils from your fingers 
that are deposited on the transparency can cause print 
quality problems. If you are using the transparencies with 
paper backing, insert a sheet of plain paper on the tray 
before loading transparencies. Doing so prevents paper 
jams while feeding.

3 Load the print material with the side you want to print 
facing down and against the right edge of the tray.

Bypass Tray

Paper support
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4 Adjust the paper guide to the width of the stack of print 
material.

Make sure that you have not loaded too much print media. 
The stack should be under the Max. fill line. The print media 
buckles if you load a stack that is too deep or if you push it 
in too far.

NOTES: When printing on previously 
used paper via the Bypass Tray, the 
printed side should be facing up with 
the uncurled edge 
at the left side. If you experience 
problems with paper feed, turn the 
paper around.

Max. fill line
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Setting the Paper Size for Copying

After loading paper in the paper Tray or the Bypass Tray, you 
need to set the correct paper size using the control panel 
buttons. These settings will apply to the Copy mode, and the Fax 
mode. In PC printing mode, you have to select the paper size in 
the application program you use.

To set the paper size for Tray, take the following steps:

1 Press Menu/Exit and then System Data from the one-
touch dial keypad. 

The display shows “CASSETTE PAPER” on the top line and 
the available options on the bottom line. The current setting 
blinks.

2 Use  or  to select the paper size you are using, and press 
Mode/Enter to save the selection.

You can press the corresponding number shown on the 
display to select the paper size.

3 To return to Standby mode, press Clear/Stop.

To set the paper size for the Bypass Tray, take the following 
steps:

1 Press Menu/Exit and then System Data from the one-
touch dial keypad. 

The display shows “CASSETTE PAPER” on the top line and 
the available options on the bottom line.

2 Use  to display “BYPASS PAPER” on the top line. The 
available options appear on the bottom line and the current 
setting blinks.

3 Use  or  to select the paper size you are using, and press 
Mode/Enter to save it. 

You can press the corresponding number shown on the 
display to select the paper size.

4 To return to Standby mode, press Clear/Stop.
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OPYING
This chapter provides step-by-step instructions for copying 
documents.

This chapter includes:

• Loading Paper for Copy Output

• Selecting a Paper Tray

• Making Copies from the Automatic Document 
Feeder

• Making Copies using the Document Glass

• Setting Copy Options

• Auto Fit Copying

• Clone Copying

• Duplex Copying

• Collation Copying



Loading Paper for Copy Output

You can copy to a size of media as small as an index card 98 x 
148 mm (3.9 x 5.8 in.) or as large as a sheet of legal-sized  216 
x 356 mm (8.5 x 14 in.) paper.

The instructions for loading the print media are the same 
whether you are printing, faxing, or copying. For details, see 
page 1.15 and page 3.6.

Selecting a Paper Tray

After loading the print media for use when copying, you have to 
select the paper tray you will use for both copy and fax jobs. 

1 Press Paper Tray. The current setting appears on the 
bottom line of the display.

2 Select “CASSETTE” or “BYPASS” by pressing Paper Tray 
repeatedly or using the navigation buttons, and press 
Mode/Enter to save the selection.

3 If you selected “BYPASS” at the step 2, the display prompts 
you to select the PAPER TYPE for the Bypass Tray. 

Use the navigation buttons to select the paper type you are 
using in the Bypass Tray.

4 Press Mode/Enter to save the selection.
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Making Copies from the Automatic 
Document Feeder

Using the ADF (Automatic Document Feeder), you can load up 
to 30 documents (20lb, 75 g/m2) in one job. Ensure that 
documents are in good condition, that they have the same 
thickness and weight, and that all of the staples and paper clips 
have been removed.

1 Feed the documents (up to 30 pages) face up into the ADF 
and adjust the document guides to the document size. 
Make sure that the bottom of the document stack matches 
the paper size marked on the ADF. 

2 Users should verify that the machine is in the Copy mode. If 
necessary, press Mode/Enter to change the mode to Copy 
mode. In Copy mode, the LCD display shows:

Note that you cannot make copies in Fax mode. The 
machine will sounds an error beep.

3 Make sure that you have selected the required paper tray. 
See page 4.2.

4 Customise the copy settings including the number of copies, 
copy size, contrast and image type using the control panel 
buttons. See “Setting Copy Options” on page 4.6.

To clear the settings, use the Clear/Stop button.

5 If necessary, you can use special copy features, such as 
collation and duplex copying. 

Document guides

Copy size Number of copies
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6 Press Start to begin copying. The display shows the copy 
processing.

NOTE: Dust on the ADF glass may cause black lines on the 
printout, so always keep it clean.

Making Copies using the Document 
Glass

If you want to make copies from booklet, pamphlet, 
transparencies, or documents having other unusual 
characteristics, use the document glass to load documents.

1 Lift the document cover.

2 Place the document face down on the glass and align it 
with document guides on the left top corner of the 
document glass.
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NOTE: Make sure that no other documents are in the ADF. If a 
document is detected in the ADF, this document has the priority 
rather than the document on the scan glass.

3 Close the scanner cover.

NOTES: 

• Leaving the cover open while copying will affect the copy quality 
and toner consumption.

• If you are copying a page from a book or magazine, close the 
cover flat. The slanted cover may cause heavy exposure of the 
light when scanning.

4 Users should verify that the machine is in the Copy mode. If 
necessary, press Mode/Enter to change the mode to Copy 
mode. In Copy mode, the LCD display shows:

Note that you cannot make copies in Fax mode. The 
machine will sounds an error beep.

5 Make sure that you have selected the required paper tray. 
See page 4.2.

6 Customise the copy settings including the number of copies, 
copy size, contrast and image type using the control panel 
buttons. See “Setting Copy Options” on page 4.6.

To clear the settings, use the Clear/Stop button.

7 If necessary, you can use special copy features, such as 
Auto Fit and Clone. 

8 Press Start to begin copying. The display shows the copy 
processing.

NOTES: 

• You can cancel a copy job while it is copying by Press the Clear/
Stop button.

• Dust on the document scanner glass may cause black spots on 
the printout, so always keep it clean.

Copy size Number of copies



Setting Copy Options

The following buttons on the control panel let you set all the basic 
copy options; contrast, image type, number of copies and copy 
size. When making a copy, use these buttons before pressing 
Start. 

Image

The Image setting is used to improve the copy quality. To select 
the image type, take the following steps:

1 Press Image. You can see the current setting on the bottom 
line of the display.

2 Press Image or the navigation buttons until the desired 
mode appears. You can choose from: 

TEXT: Used for documents containing mostly text.

MIXED: Used for documents with mixed text and graphics.

PHOTO: Used when the originals are photographs.

3 Press Mode/Enter to save the selection.
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Contrast

If you have an original document containing faint markings or 
dark images, you can adjust the brightness to make a copy that 
is easier to read. To adjust the contrast, take the following 
steps:

1 Press Contrast. 

2 Press Contrast or the navigation buttons to select an 
option and press Mode/Enter.

MANUAL: You can adjust the contrast manually. Continue 
to the next step.

AUTO SUPPRESS: Use this setting for copying an original 
from a newspaper or magazine to remove its background 
image. This setting is available only in the Copy mode.

3 When you select Manual, choose from 5 contrast settings 
using the navigation buttons.

Each time you press the button, the selection block on the 
LCD display moves to the left or to the right. As the 
selection block moves to the right, the contrast becomes 
darker.

4 Press Mode/Enter to save the selection.

Set

Using the Set ( ) button, you can select the number of copies, 
from 1 to 999. 

1 Press Set ( ). The triangle symbol on the middle of the top 
line heads for the number of copies.

2 Enter the number of copies using the number keypad. The 
selected number appears on the display.

You can also use Increase ( ) or Decrease ( ) to change 
the number of copies. Press Increase ( ) or Decrease 
( ) to increase or decrease the number by 1. If you press 
and hold the buttons, the number increases or decreases 
rapidly. 

3 Press Mode/Enter to save the selection.

Selection block



Zoom

Using the Zoom ( ) button, you can reduce or enlarge the size 
of a copied image by 25% to 400% when you copy the original 
from the document scanner glass, and by 25% to 100% using 
the ADF. Note that the zoom rate available is different according 
to the document loading method.

1 Press Zoom ( ). The triangle symbol on the middle of the 
top line points to the zoom rate.

2 Enter the size using the number keypad. The selected 
number appears on the display.

You can also use Increase ( ) or Decrease ( ) to change 
the zoom rate. Press Increase ( ) or Decrease ( ) to 
increase or decrease the number by 1. If you press and hold 
the buttons, the number increases or decreases rapidly. 

3 Press Mode/Enter to save the selection.

NOTES: 

• If you press the Clear/Stop button while setting the copy 
options and before starting to copy, all the copy options you 
have set for the current copy job will be cancelled and return to 
their default values.

• When reducing, black lines may appear at the bottom of the 
copy.
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Auto Fit Copying

This feature automatically reduces or enlarges the original 
image to fit on the paper currently loaded in the machine, so you 
don’t need to adjust the copy size.

This special copy mode is only available when using document 
scanner glass. If a document is detected in the ADF, the auto-fit 
will not work.

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Make sure that you have selected the required paper tray. 
See page 4.2.

3 To enter the special copy mode, Users should press Special 
Copy in the Copy mode (see page 4.5).

4 Press Special Copy repeatedly or use the navigation 
buttons until “AUTO FIT” appears on the bottom line of the 
display.

5 Press Mode/Enter to save the selection.

6 If necessary, customise the copy settings including the 
number of copies, contrast and image type using the 
control panel buttons. See “Setting Copy Options” on 
page 4.6.

NOTE: You cannot adjust the copy size using the Zoom button 
while Auto fit is enabled.

7 Press Start to begin copying.

8 When copying is completed, press Clear/Stop to cancel 
the Auto Fit mode.
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Clone Copying

The Clone feature prints multiple image copies on a single page. 
The number of images is automatically determined by the 
original image size, so you are unable to adjust the copy size.

This special copy mode is available only when using the 
document scanner glass. If a document is detected on the ADF, 
the Clone option will not work.

1 Load the document to be copied on the document glass, 
and close the cover. 

2 Make sure that you have selected the required paper tray. 
See page 4.2.

3 To enter the special copy mode, Users should press Special 
Copy in the Copy mode (see page 4.5).

4 Press Special Copy repeatedly or use the navigation 
buttons until “CLONE” appears on the bottom line of the 
display.

5 Press Mode/Enter to save the selection.

6 If necessary, customise the copy settings including the 
number of copies, contrast and image type using the 
control panel buttons. See “Setting Copy Options” on 
page 4.6.

NOTE: You cannot adjust the copy size using the Zoom button 
while making a clone.

7 Press Start to begin copying.

8 When the copying is completed, press Clear/Stop to 
cancel the Clone mode.
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Duplex Copying

Duplex copying allows you to print on both sides of the paper.

Before printing in the duplex mode, decide on which edge you 
will bind your finished document. The binding options are:
LONG EDGE, which is the conventional layout used in book 
binding.
SHORT EDGE, which is the type often used with calendars.

1 Load the documents to be copied in the ADF. 
Make sure that the original document is single sided. 

Or, place a sheet of the documents on the document glass 
face down.

2 Make sure that you have selected the required paper tray. 
See page 4.2.

3 Press Duplex Copy. The current setting appears on the 
bottom line of the display.

4 Press Duplex Copy or use the navigation buttons to select 
the binding orientation. If you select “OFF”, you cannot use 
duplex copying.

5 Press Mode/Enter to save the selection.

6 If necessary, customise the copy settings including the 
number of copies, copy size, contrast and image type using 
the control panel buttons. See “Setting Copy Options” on 
page 4.6.

NOTE: In duplex copy mode, the PHOTO setting using the Image 
button is disabled. 

7 Press Start to begin copying.

Long Edge

Short Edge
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8 When the document is fed from the document glass, the 
display shows “SCAN SIDE 2?” on the top line after the 
page is scanned into the memory. To scan another page, 
remove the scanned page and load the next page on the 
glass. Select “YES” and press Mode/Enter. 

After scanning, the machine starts printing automatically. 
Then the display shows "SCAN ANOTHER?". To scan another 
page, select "YES" and press Mode/Enter. 

When the display shows "SCAN SIDE2?" again, repeat as 
necessary.

When all of the pages are scanned, select “NO” when the 
display shows “SCAN SIDE 2?” or “SCAN ANOTHER ?” and 
press Mode/Enter.

9 When the copying is completed, press Clear/Stop to 
cancel the duplex copy mode.

Collation Copying

When the Collation Copying feature is on, your machine sorts 
the copy job. For example, if you make 2 copies of 3 pages 
documents, one complete 3 page document will print followed 
by the second complete 3 page document.

1 Load the documents to be copied in the ADF.

Or, place a sheet of the documents on the document glass 
face down.

2 Make sure that you have selected the required paper tray. 
See page 4.2.

3 To enter collation copy mode, Users should press Special 
Copy in the Copy mode (see page 4.3). Press Special 
Copy or use the navigation buttons until “COLLATION” 
appears on the bottom line of the display.

4 Press Mode/Enter to save the selection.
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5 If necessary, customise the copy settings including the 
number of copies, copy size, contrast and image type using 
the control panel buttons. See “Setting Copy Options” on 
page 4.6.

6 Press Start to begin copying.

NOTE: In duplex copy mode, the PHOTO setting using the Image 
button is disabled. 

7 When the document is fed from the document glass, the 
display shows “SCAN ANOTHER?” on the top line after the 
page is scanned into the memory. To scan another page, 
remove the scanned page and load the next page on the 
glass. Select “YES” and press Mode/Enter. Repeat as 
necessary.

When all of the pages are scanned, select “NO” when the 
display shows “SCAN ANOTHER?” and press Mode/Enter.

8 When copying is completed, press Clear/Stop to cancel 
the collation copy mode.
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 PRINTING
Read this chapter to learn how to select and load print 
media and how to use the print settings. 

This topics included in this chapter are:

• Printing a Document

• Printer Settings

• Printing Multiple Pages on One Sheet of Paper (N-
Up Printing)

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Printing Posters

• Using Watermarks

• Using Overlays

• Setting Graphic Properties

• Setting Up the Locally Shared Printer



Printing a Document

This procedure describes the general steps required for printing 
from various Windows applications. The exact steps for printing 
a document may vary depending on the application program you 
are using. Refer to your software application’s for the exact 
printing procedure.

The following steps describe the typical process to print from 
Windows:

1 Ensure that your machine is properly connected to the 
computer, the machine is powered on, and there is paper in 
the paper tray.

2 Verify that you have installed the software for your 
computer. For details, see “Installing the Software” on 
page 2.4.

3 Start the program you are using to create the document, 
and create or open the document you want to print. 

4 Choose Print or Print Setup from the File menu. Make 
sure that Type 102 PCL 6 is selected as your default 
printer. Click Properties or Setup if you want to make any 
adjustments that are appropriate for printing your 
document. For details, see “Printer Settings” on page 5.3.

5 Click OK to close the Properties dialogue box.
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6 After making any necessary changes to the printing 
parameters, click OK to start the print job.

Printer Settings

You can use the machine with all your Windows 95/98/Me/2000/
XP or Windows NT 4.0 applications. Be sure to set Type 102 PCL 
6 as the default printer for all of your Windows operations.

Most Windows software applications allow you to make changes 
to the printer settings. This includes settings that determine 
how a print job looks such as paper size, paper orientation, and 
margins. Settings made in the application to create the 
document will usually override settings made in the printer 
driver.

NOTE: You do not need to use any of the control panel buttons to 
use the machine as a PC printer. For example, if you want to adjust 
the printing contrast you do not have to press Contrast on the 
control panel. The control panel buttons are used primarily for 
copying.

Accessing Printer Settings

You can access printer settings by using either of these 
methods.

Windows 95/98/Me

• Select the File > Print > Properties or File > Print Setup 
command from within any Windows application.

Or

• Select Type 102 PCL 6 printer from the Printers folder, then 
select File > Properties (or select the printer icon in the 
Printers folder, and click the right mouse button).

Windows NT 4.0

•  Select the File > Print > Properties or File > Print Setup 
command from within any Windows application.
Or
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• Select Type 102 PCL 6 printer from the Printers folder, click 
the right mouse button, then select Document Defaults 
from the drop-down list.

Windows 2000

• Select the File > Print command from within any Windows 
application.
Or

• Select Type 102 PCL 6 printer from the Printers folder, click 
the right mouse button, then select Properties and  
Printing Preferences from the drop-down list.

Windows XP

•  Select the File > Print > Preferences command from 
within any Windows application.

•  Select Type 102 PCL 6 printer from the Printers and 
Faxes folder, click the right mouse button, then select 
Printing Preferences from the drop-down list.

Printer Properties Tabs

When Printer Properties are displayed, you can review and 
change whatever settings are needed for your printer job.

Your printer’s Properties window consists of 5 tabs: Layout, 
Paper, Graphic, Extras and About.

If you access the Printer Properties through the Printers folder, 
you can view more Windows-based tabs, in addition to these 5 
tabs. For information on the Windows-based tabs, refer to your 
Windows User’s Guide.

The printer’s Properties window may differ depending on the 
operating system used. This Operating Instructions shows the 
Properties window on Windows unless otherwise specified.

NOTE: If you access Printer Properties through the Printers 
folder, any settings made will become the default settings for the 
printer. Settings made when Printer Properties are accessed 
through an application File menu and Print or Print Setup will 
remain active until the application you are printing from is closed.
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Paper Tab 

Use the Paper tab to select the size of paper you have in your 
printer, the orientation, the number of copies to print, etc.

Select the size of paper you are using.

Select the desired paper 
source. Select Tray if you 
load media in the paper Tray, 
Bypass Tray if you load in 
the Bypass Tray.

Select the type of paper you 
are using.

Select the desired paper 
source for the first page and 
other pages independently.

1

2

3

4

1

2

3

4
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Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of 
paper. To print more than one page per sheet, the pages will 
appear decreased in size and arranged on the sheet. You can 
print up to 16 pages on one sheet.

1 To change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, choose Multiple Pages per Side on 
the Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9 or 16) on the Pages per Side drop-down list.

4 Select the page order on the Page Order drop-down list, if 
necessary.

Check Print Page Border to print a border around each 
page on the sheet. Print Page Border is enabled only, if 
the pages per sheet is 2, 4, 6, 9 or 16.

1 2

3 4

Right, Then 
Down

1

3

2

4

1

2

3

4

2

4

1

3

3

4

1

2
Down, Then 
Right

Left, Then 
Down

Down, Then 
Left
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5 Click the Paper tab and select the paper source, size and 
type.

6 Click OK and print the document. 

Printing a Reduced or Enlarged 
Document

You can scale your print job on a page. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 From the Paper tab, select Reduce/Enlarge on the Type 
drop-down list. 

3 Enter the scaling rate in the Percentage input box. 

You can also click the ��or ❷ button.

4 Click the Paper tab and select the paper source, size and 
type. 

5 Click OK and print the document. 
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Fitting Your Document to a Selected 
Paper Size

You can scale your print job to any selected paper size 
regardless of the digital document size. This can be useful when 
you want to check fine details on a small document. 

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Paper tab, select Fit to Page on the Type 
drop-down list. 

3 Select the correct size from the Target Page drop-down 
list.

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. 

A
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Printing Posters

You can print a single-page document onto 4, 9 or 16 sheets of 
paper, for the purpose of pasting the sheets together to form 
one poster-size document.

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Layout tab, select Poster on the Type 
drop-down list. 

3 Configure the poster option:

You can select the page layout from 2x2, 3x3 or 4x4. If you 
select 2x2, the output will be automatically stretched to 
cover 4 physical pages. 

��2 x 2

��3 x 3
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Specify an overlap in millimeters or inches to make it 
easier to reconstruct the resulting poster. 

4 Click the Paper tab and select the paper source, size and 
type.

5 Click OK and print the document. You can complete the 
poster by reconstructing the results. 

Using Watermarks

The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across 
the first page or all pages of a document. 

There are several predefined watermarks that come with your 
machine, and they can be modified or you can add new ones to 
the list. 

Using an Existing Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and select a watermark on the 
Watermark drop-down list. It appears in the preview 
image window. 

0.15 inches

0.15 inches

Preview 
image
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3 Click Ok and start printing. 

Creating a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermarks window 
appears. 

3 Enter the text message you want to print in the 
Watermark Message box. 

The message displays in the preview image window. The 
preview image is provided so that you can see how the 
watermark will appear on the printed page.

When the First Page Only box is checked, the watermark 
is printed on the first page only.

4 Select the watermark options. 

You can select the font name, style and size and gray scale 
level from the Font Attributes section and set the angle of 
the watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list. 

6 When you finish creating, click Ok and start printing. 

To stop printing the watermark, select <No Watermark> on 
the Watermark drop-down list. 
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Editing a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermarks window 
appears.

3 Select the watermark you want to edit on the Current 
Watermarks list, and change the watermark message and 
the options. Refer to “Creating a Watermark” on page 11. 

4 Click Update to save the changes.

5 Click Ok. 

Deleting a Watermark

1 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermarks window 
appears.

3 Select the watermark you want to delete on the Current 
Watermarks list and click Delete. 

4 Click Ok.
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PRINTING 5.13

Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the machine. You need 
only tell the machine to print the letterhead overlay on your 
document.

Creating a New Page Overlay

To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as 
you wish them to appear when printed as an overlay. If 
needed, save the file for later use.

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2.

3 Click the Extras tab and click Edit button in the Overlay 
section. 

WORLD BEST

Dear ABC

Regards

WORLD BEST



4 In the Edit Overlays window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. You can see the name on the Overlay List. 

7 Click OK or Yes until you complete creating. 

The file is not printed out. Instead it is stored in your 
computer HDD disk. 

NOTE: The overlay document size must be the same as document 
you will print with the overlay.
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Using a Page Overlay

After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 When you change the print settings from your software 
application, access the printer properties. See page 5.2. 

3 Click the Extras tab. 

4 Select the overlay you want to print from the Overlay 
drop-down list box. 

5 When the overlay file doesn’t appear on the Overlay List, 
click the Edit button and Load Overlay, and select the 
overlay file. 

If you have stored the overlay file you want to use into an 
external source, you can also load the file when you access 
this Load Overlay window. 

After you select the file, click Open. The file is now shown 
in the Overlay List box and is available for printing. Select 
the overlay from the Overlay List box. 
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6 If necessary, click Confirm Page Overlay When 
Printing. When this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on your 
document. 

Answering Yes to the window means that the selected 
overlay will be printed with your document. Answering No 
to the window cancels overlay printing. 

If this box is empty and an overlay has been selected, the 
overlay will be automatically printed with your document. 

7 Click OK or Yes until the printing starts. 

The overlay is downloaded with your print job and printed 
on your document. 

NOTE: The resolution of the overlay document must be the same 
as that of the document you will print with the overlay.  

Deleting a Page Overlay

You can delete page overlays that are no longer used. 

1 In the printer properties window, click the Extras tab. 

2 Click Edit in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 Click OK until you exit the Print window.
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Setting Graphic Properties

Use the following graphic options to adjust the print quality for 
your specific printing needs. See page 5.2 for more information 
about accessing printer properties.

Click the Graphics tab to display the properties shown below. 

Property Description

Resolution

You can select the printing resolution by 
choosing from 1200 dpi class (Best), 
600 dpi (Normal) or 300 dpi (Draft). 
The higher the setting, the sharper the 
clarity of printed characters and graphics. 
Higher settings may increase time it takes 
to print a document.

1

3

2

4

1
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Image
     Mode

When you print with the resolution of 300, 
600, 1200 dpi, some printed characters or 
images can appear to have jagged or 
uneven edges. Set this Resolution 
enhancement Technology (RT) option to 
improve the print quality of your text and 
images, make the characters and images 
appear smoother.
• Printer Default - Choose this setting to 

use the RT that your printer provides. You 
can select this when resolution is 600/300 
dpi.

• Normal - Choose to disable RT mode. You 
can select this when resolution is 600/300 
dpi.

• Text Enhance - Choose to refine the 
print quality of characters by smoothing 
out jagged edges that can occur on the 
angles and curves of each character. You 
can select this when resolution is 1200/
300 dpi.

• Image Enhance - Choose to refine the 
print quality of photo images using RT. You 
can select this when resolution is 1200 
dpi.

Toner Save
      Mode

Selecting this option extends the life of your 
toner cartridge and reduces your cost per 
page without a significant reduction in the 
print quality. 
• On: Select this option to allow the printer 

to use less toner on each page.
• Off: When you do not need to save toner 

to print a document, select this option.

Property Description

2

3

PRINTING5.18



5

TrueType 
Options 

You can set TrueType settings by clicking the 
TrueType Options button. 

Property Description

4

True Type Options
This option determines what the driver 
tells the machine about how to image the 
text in your document. Select the 
appropriate setting according to the status 
of your document. 
• Download as Outline: When this 

option is selected, the driver will 
download any TrueType fonts that are 
used in your document not already 
stored (resident) on your printer. 

• Download as Bit Image: When this 
option is selected, the driver downloads 
the font data as bitmap images. 
Documents with complicated fonts, such 
as Korean or Chinese, or various types of 
fonts print faster in this setting. 

• Print as Graphics: When this option is 
selected, the driver downloads any fonts 
as graphics. When printing documents 
with high graphic content and relatively 
few TrueType fonts, printing performance 
(speed) may be enhanced in this setting.

Print All Text Black
When the Print All Text Black option is 
checked, all text in your document is 
allowed to print solid black, regardless of 
the colour it appears on the screen. When 
it is not checked, coloured text is allowed 
to print in shades of gray.
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About Tab

The About tab gives you the program version number.

Printer Properties Buttons & Icons
• Click OK when you finish reviewing or making changes.

• Click Cancel if you want to exit the tab menus without 
applying any changes.

• Click Help to view the online Help feature and tab menu 
details.

• Click the ? icon in the title bar to get information about 
specific setting on the page. Position the ? pointer over the 
parameter in question and click to see a pop-up window for 
an explanation.

Setting Up the Locally Shared 
Printer

You can connect the machine directly to a selected computer, 
which is called “host computer,” on the network. Your machine 
can be shared by other users on the network through a Windows 
9x, Me, 2000, XP or NT 4.0 network printer connection. 

NOTE: Whether the printer is locally connected or network-
connected, you need to install the printer software on each 
computer that will print documents to the printer.

In Windows 9x/Me

Setting Up the Host Computer

1 Start Windows.

2 From the Start menu, select Control Panel and 
double-click on the Network icon. 
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3 Check the File and Print Sharing box and click OK. 

4 Click Start and select Printers from Settings. Double-
click your printer name. 

5 Select Properties in the Printer menu. 

6 Click the Sharing tab and check the Shared As box. Fill in 
the Shared Name field and then click OK. 

Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Right-click the shared name and select Capture Printer 
Port. 

4 Select the port you want, check the Reconnect at log on 
box and then click OK.

5 From the Start menu, select Settings and then Printers. 

6 Double-click your printer icon. 

7 From the Printer menu, select Properties. 

8 From the Details tab, select the printer port and click OK.

 

In Windows NT 4.0/2000/XP

Setting Up the Host Computer

1 Start Windows. 

2 For Windows NT 4.0/2000, from the Start menu, select 
Settings and then Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes. 
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3 Double-click your printer icon. 

4 From the Printer menu, select Sharing. 

5 For Windows NT 4.0, check the Shared box. 

For Windows 2000, check the Shared As box.

For Windows XP, check the Share this printer box. 

6 For Windows NT 4.0, fill in the Share Name field and click 
OK. 

For Windows 2000/XP, fill in the Shared Name field and 
click OK. 

Setting Up the Client Computer

1 Right-click Start and select Explorer. 

2 Open your network folder in the left column. 

3 Click the shared name. 

4 For Windows NT 4.0/2000, from the Start menu, select 
Settings and Printers. 

For Windows XP, from the Start menu, select Printers and 
Faxes.

5 Double-click your printer icon. 

6 From the Printer menu, select Properties. 

7 Press the Ports tab and click Add Port. 

8 Select Local Port and click New Port. 

9 Fill in the Enter a port name field and enter the shared 
name. 

10 Click OK and click Close. 

11 For Windows NT 4.0, click OK.

For Windows 2000/XP, click Apply and click OK.
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 SCANNING
Scanning with your machine lets you turn pictures and text 
into digital files on your computer.

This chapter includes:

• Scanning Process with TWAIN-enabled Software



Scanning Process with TWAIN-
enabled Software 

If you want to scan documents using other software, you will 
need to use TWAIN-compliant software, such as Adobe 
PhotoDeluxe or Adobe Photoshop. The first time you scan with 
your machine, you will need to select it as your TWAIN source in 
the application you will use. 

The basic scanning process involves a number of steps:
• Place your photograph or page on the document glass.
• Open an application, such as PhotoDeluxe or Photoshop. 
• Open the TWAIN window and setting the scan options.
• Scan and save your scanned image.

You need to follow the program’s instructions for acquiring an 
image. Please refer to the Operating Instructions for the 
application.
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 MAINTENANCE
This chapter provides information for maintaining the 
cartridge and your machine.

This chapter includes:

• Cleaning the Scan Unit

• Expected Cartridge Life

• Replacing the Toner Cartridge

• Setting to Notify Toner Low

• Cleaning the Drum

• Replacing the Drum Cartridge

• Setting the machine to be Checked by Phone



Cleaning the Scan Unit

Keeping the scan unit clean helps ensure the best possible 
copies. We suggests that you clean the scan unit at the start of 
each day and during the day as needed.

NOTE: 
• Cleaning the cabinet of the printer with surfactants containing 

large amounts of alcohol, solvent or other strong substances can 
discolor or crack the cabinet.

• Clean the cabinet of the printer with a soft, lint-free cloth. You 
can dampen the cloth slightly with water, but be careful not to be 
let any water drip onto the printer or inside of it.

1 Slightly dampen a soft lint-free cloth or paper towel with 
water.

2 Open the document cover.

3 Wipe the surface of the document glass and ADF glass until 
it is clean and dry.

4 Wipe the underside of the white document cover and white 
sheet until it is clean and dry.

5 Close the document cover.

Document cover

Document Glass

White sheet

ADF glass
MAINTENANCE7.2



7

Expected Cartridge Life

The life of your toner cartridge depends on the amount of toner 
used in each print job. For instance, when you print a typical 
business letter with about 5% page coverage, you can expect a 
toner cartridge life of approximately 6,000 pages.(The original 
toner cartridge supplied with the printer lasts an average of 
3,000 pages.) The actual number may vary according to the 
print density of the page you print. If you print a lot of graphics, 
you may need to change the cartridge more often.

Replacing the Toner Cartridge

When the toner cartridge is near the end of its life, white streaks 
or light copy will occur. The LCD displays a warning message 
“TONER LOW.” You can temporarily re-establish the print quality 
by re-distributing the remaining toner in the cartridge. 
To do this:

1 Pull the release lever to open the side cover.
MAINTENANCE 7.3



2  Open the front cover.

3 Turn the cartridge locking lever upwards to release the 
toner cartridge.

4 Pull the toner cartridge out and gently shake the cartridge 
to distribute the toner evenly inside the cartridge.

NOTE: If the toner gets on your clothing, wipe it off with a dry 
cloth and wash clothing in cold water. Hot water sets the toner into 
fabric.
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5 Reinstall the cartridge and turn the cartridge locking lever 
downwards.

6 Close the front cover, then the side cover. The display shows 
“NEW TONER? 1.YES 2.NO.”

7 Select “NO” by pressing 2. The machine returns to Standby 
mode. This is typically successful only one time.

When the toner eventually runs out, only blank pages will print 
when a print job is sent, or when a fax is received. At this stage, 
the toner cartridge needs to be replaced. The display shows the 
warning message “TONER EMPTY.”

Take the following steps to replace the toner cartridge:

1 The side cover must be open to open the front cover.

Make sure that the side cover is open before opening the 
front cover.

2 Turn the cartridge locking lever upwards to release the 
toner cartridge.
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3 Pull the used cartridge out.

NOTE: Help the environment by recycling your used toner 
cartridge. Refer to the recycling brochure packed with the toner 
cartridge for details.

4 Shake the new toner cartridge horizontally four or five 
times.

Save the box and the cover for shipping.

5 Slide the new toner cartridge in until it locks in place.

6 Turn the cartridge locking lever downwards until it locks in 
place.

7 Close the front cover, then the side cover. The display shows 
“NEW TONER? 1.YES 2.NO”.

8 Select “YES” by pressing 1. The machine returns to Standby 
mode.
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Setting to Notify Toner Low 

If you have set this NOTIFY TONER LOW menu option to “ON,” 
your machine automatically sends a fax to your service company 
or the dealer to notify them that your machine requires a new 
toner cartridge when the toner cartridge needs to be replaced. 
The fax number is preset by your dealer when you bought your 
machine. 

1 Press Menu/Exit and then Maintenance from the one-
touch dial keypad. 

2 Use  or  until “NOTIFY TONER” appears on the bottom 
line of the display, and press Mode/Enter.

“NOTIFY TONER LOW” appears on the top line and the 
current setting appears on the bottom line. 

3 Press  or  to change the setting. Select “ON” to enable 
this feature, then press Mode/Enter.

Select “OFF” disables this feature.

4 Enter your fax number, and then press Mode/Enter.

5 Enter your name of up to 20 digits, and then press Mode/
Enter.

6 Enter the service company’s phone number to which your 
machine sends the fax message to notify Toner Low, and 
then press Mode/Enter.

7 Enter the serial number of your machine, and then press 
Mode/Enter.
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Cleaning the Drum

If there are streaks or spots on your print, the drum cartridge 
may require cleaning.

1 Before setting the cleaning procedure, make sure that 
paper is loaded in the machine. 

2 Users should press Menu/Exit then Maintenance from 
the one-touch dial keypad. 

3 “CLEAN DRUM” appears on the bottom line of the display. 
Press Mode/Enter.

4 The machine prints out a cleaning page. Toner particles on 
the drum surface are affixed to the paper. Repeat this 
process three or four times.

Replacing the Drum Cartridge

The useful life of the drum cartridge is approximately 15,000 
copies. The LCD displays “DRUM WARNING” when the drum is 
near the end of life. Approximately 1,000 more copies can be 
made, but you should have a replacement drum cartridge in 
stock. When “DRUM EMPTY” is displayed, the machine will stop 
operating until the drum cartridge is replaced.

To replace the drum cartridge:

1 Open the side cover, then the front cover.
The side cover is open before opening the front cover.
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2 Turn the cartridge locking lever upwards to unlock the toner 
cartridge, then pull the toner cartridge out.

NOTE: The toner cartridge must be removed to replace the drum 
cartridge.

3 Pull the used drum cartridge out.

NOTE: Help the environment by recycling your used drum 
cartridge. Refer to the recycling brochure packed with the drum 
cartridge for details.

4 Unpack the new drum cartridge and slide it into place, 
making sure not to touch the surface of the drum.
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5 Reinstall the toner cartridge, and then lock the lever.

NOTE: If your machine automatically recognises the replaced 
cartridge, you can skip steps 6 and 7.

6 Close the front cover and the side cover. The LCD displays 
“NEW DRUM? 1.YES 2.NO”.

7 Select “YES” by pressing 1. The machine returns to Standby 
mode.

If the drum cartridge does not work properly and you have to 
replace it with a new one before “DRUM WARNING” or “DRUM 
EMPTY” may appears on the display, replace the drum cartridge 
as described above then take the following steps to reset the 
drum counter:

1 Press Menu/Exit then Maintenance from the one-touch 
dial keypad. 

2 Use  or  until “NEW DRUM” appears on the bottom line 
of the display, and press Mode/Enter.

3  “NEW DRUM UNIT?” appears on the top line and “1.YES 
2.NO” appears on the bottom line. Press 1 to select “1.YES.” 

NOTE: If you do not reset the counter, “DRUM WARNING” or 
“DRUM ENPTY” may appear before the current drum cartridge’s 
time is up. 
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Setting the machine to be Checked 
by Phone

The Remote Test feature allows your machine to be checked out 
by a service company at a remote place by phone.

1 Press Menu/Exit and then Maintenance from the one-
touch dial keypad. 

2 Use  or  until “REMOTE TEST” appears on the bottom 
line of the display, and press Mode/Enter.

3 Press  or  to change the setting. 

Select “On” to enable this feature. Selecting “Off” disables 
this feature.

If you want to protect your machine from being opened by 
an unauthorized person, select “Off”. 

4 Press Mode/Enter to save the selection.

NOTE: This feature is not available in some areas. 
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 TROUBLESHOOTING
This chapter gives helpful information for what to do if you 
encounter an error.

This chapter includes:

• Document Jams

• Paper Jams

• LCD Error Messages

• Solving Problems



Document Jams

If a document jams while it is feeding through the ADF, 
“DOCUMENT JAM” appears on the display.

Details for clearing the three types of document misfeeds are 
given below.

Input Misfeed

1 Open the ADF top cover.

2 Pull the document gently to the right and out of the ADF.

3 Close the ADF top cover. Then place the documents back 
into the ADF.

NOTE: To prevent document jams, use the document scanner 
glass for thick, thin or mixed documents. 
TROUBLESHOOTING8.2



8

Exit Misfeed

1 Open the document cover and turn the release knob to 
remove the misfed documents from the exit area.

2 Close the document cover. Then place the documents back 
into the ADF.

Roller Misfeed

1 Open the document cover.

2 Turn the release knob so that you can easily seize the 
misfed document, and remove the document from the ADF 
or the feed area by carefully pulling it rightwards using both 
hands.

3 Close the document cover. Then place the documents back 
into the ADF.
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Paper Jams

If paper jams occur, “PAPER JAM” appears on the display. Follow 
the steps below to clear the jam. To avoid tearing the paper, pull 
the jammed paper out gently and slowly.

Paper Feed Area

If the paper jammed in the feed area, “PAPER JAM0” appears in 
the display.

1 Pull the paper Tray open. After you pull it out completely, lift 
the front part of the Tray slightly up to release the Tray from 
the machine. 

2 Remove the jammed paper by gently pulling it straight out.

Once you remove the jammed paper here, open the side 
cover and then close it to clear the “PAPER JAM” message 
on the display.
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If there is any resistance, and the paper does not move 
immediately when you pull, stop pulling. Then:

3 Pull the release lever to open the side cover.

NOTE: Do not touch the shiny drum cartridge surface. Scratches 
or smudges will result in poor copy quality.

4  Carefully remove the misfed paper in the direction shown.

5 Close the cover and insert the paper Tray. Lower the rear 
part of the Tray to align the rear edge to the corresponding 
slot of the machine, then insert it completely.
TROUBLESHOOTING 8.5
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Fuser Area

If the paper jammed in the fuser area, “PAPER JAM 1” appears 
on the display:

1 Lift the release lever to open the side cover.

2 Pull down on the fuser lever as shown below.
This will release pressure on the paper.

If paper is not seen in this area, skip to the Exit Area.

WARNING: The fusing area at the rear part of the inside of your 
machine is hot when powered.Be careful not to be burned when 
you access this area.

3 Remove the jammed paper, in the direction shown.

NOTE: Do not pull paper up through the fusing unit. Unfused 
toner may adhere in the area, resulting in smudged copies.
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4 Push the fuser lever up, and then close the side cover.

Paper Exit Area

If the paper jammed in the exit area, “PAPER JAM 2” appears on 
the display.

1 Press the release lever to open the side cover.

2 Open the front cover.
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3 Pull down on the fuser lever. This will release pressure on 
the paper.

4 Turn the Jam Remove Lever in the direction of the arrow to 
move the paper to the exit area, then gently pull the paper 
out through the exit area.

5 Push the fuser lever up.
TROUBLESHOOTING8.8
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6 Turn the Jam Remove Lever back to the original position.

7 Close the front cover  and the side cover .

Duplex Jam

If paper jam occurs in the duplexer, “DUPLEX JAM” appears on 
the display.

1 Press the release lever to open the side cover.

2 Remove the jammed paper. Then close the side cover.

1 2

1

2
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Bypass Tray Jam

“BYPASS JAM” appears on the display when you try to print 
using the Bypass Tray and the machine does not detect paper 
due to no paper or improper paper loading.

“BYPASS JAM” also may occur when the paper is not properly fed 
into the machine through the Bypass Tray. In that case, pull the 
paper out of the machine.
TROUBLESHOOTING8.10
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LCD Error Messages

Display Meaning Solution

BYPASS JAM
The machine detects no 
feeding from the Bypass 
Tray.

Load paper in the Bypass Tray.

DOCUMENT JAM The loaded document 
has jammed in the ADF.

Clear the document jam. See 
page 8.2.

DOOR OPEN The side cover is not 
securely latched.

Close the side cover until it locks 
into place.

DRUM WARNING The drum cartridge is 
near the end of its life.

You should have a replacement 
cartridge in stock.

DUPLEX JAM
Paper has jammed in the 
middle of a 2-sided print 
job.

Clear the jam. See page 8.9.

DRUM EMPTY The drum cartridge is 
empty.

Replace the drum cartridge. See 
page 7.8.

FUSER ERROR

There is a problem in the 
fuser unit.

Unplug the power cord and plug it 
back in. If the problem still 
persists, please call for your sales 
or service representative.

OPEN HEAT ERROR

HEATTING ERROR

OVER HEAT

INVALID 
CARTRIDGE

You have used an 
unauthorised cartridge.

You must use a approved 
cartridge.

LINE ERROR

Your machine cannot 
connect with the remote 
machine, or has lost 
contact because of a 
problem with the phone 
line.

Try again. If the problem persists, 
wait an hour or so for the line to 
clear, then try again. 

Or, turn the ECM mode on. See 
‘System Data Options’ in the 
Facsimile Reference.

LSU ERROR
A problem has occurred 
in the LSU (Laser 
Scanning Unit).

Unplug the power cord and plug it 
back in. If the problem still 
persists, please call for your sales 
or service representative.
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MEMORY FULL The memory is full.

Either delete unnecessary 
documents, retransmit after more 
memory becomes available, or 
split the transmission into more 
than one operation.

NO ANSWER
The remote fax machine 
has not answered after 
several redial attempts.

Try again. Make sure the remote 
machine is operational.

POLLING ERROR

The remote fax machine 
you want to poll is not 
ready to respond to your 
poll.

Or, when setting up to 
poll another fax 
machine, you have used 
an incorrect poll code.

The remote operator should know 
in advance that you are polling 
and have the fax machine loaded 
with the original document.

Enter the correct poll code.

NO DEVELOPER 
CARTRIDGE

The drum cartridge is not 
installed. Install the drum cartridge.

NO PAPER The paper in the paper 
Tray has run out. Load paper in the paper Tray.

RX TRAY FULL Paper is overstacked in 
the output bin. Remove paper.

PAPER JAM 0
Paper has jammed in the 
paper feeding area of the 
Tray.

Clear the jam. See page 8.4.

PAPER JAM 1 Paper has jammed in the 
fuser area. Clear the jam. See page 8.6.

PAPER JAM 2 Paper has jammed in the 
paper exit area. Clear the jam. See page 8.7.

RETRY REDIAL?

The machine is waiting 
for a specified time 
interval to redial a 
previously busy station.

You can press Mode/Enter to 
immediately redial, or Clear/
Stop to cancel the redial 
operation.

SCANNER LOCKED The scan module is 
locked.

Unlock the scanner (see 
page 1.2) and press Clear/
Stop.

Display Meaning Solution
TROUBLESHOOTING8.12
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Solving Problems

The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until 
the problem is corrected. If the problem persists, please contact 
a service engineer.

Copier Problem Solution Chart

TONER EMPTY
The toner cartridge has 
run out. The machine 
stops.

Replace with a new toner 
cartridge. See page 7.3.

TONER LOW The toner is almost 
empty.

Take out the toner cartridge and 
gently shake it. By doing this, you 
can temporarily re-establish 
printing operations.

Display Meaning Solution

Condition Suggested solutions

The LCD does not turn on.

Check that the machine is plugged into an electrical 
supply.
Ensure that there is power to the socket where the 
unit is plugged in to and that the machine power 
switch is in the ON position.

The machine beeps an error 
sound and does not make a 
copy.

Make sure that the machine is in copy mode. If not, 
change the mode to the Copy mode by pressing 
Mode/Enter. 

Copies are too light or too 
dark.

If the original is light, use the Contrast button to 
darken the background of the copies.

If the original is dark, use the Contrast button to 
lighten the background of the copies.

Smears, lines, marks, or 
spots on copies.

If the detects are on the original, press the Contrast 
button to lighten the background of your copies.

If no defects are on the original, clean the document 
glass and underside of the document cover.

White or black lines on 
your copy.

Check to see if the temperature is too low. When it 
is lower than 10 oC , copy your document 1 hour 
after you turn the machine on.
TROUBLESHOOTING 8.13



Copy image is skewed.

Ensure that original is positioned correctly on 
document glass.

Check that the copy paper is loaded correctly.

Blank copies. Ensure that the original is face down on the 
document glass or face up in the ADF.

Image rubs off the copy 
easily.

Replace the paper in the Tray with paper from a new 
package.

In high humidity areas do not leave paper in the 
machine for extended periods of time.

Frequent copy paper jams.

Fan the stack of paper, then turn it over in the Tray. 
Replace the paper in paper Tray with a fresh supply. 
Check/adjust the paper guides, if necessary.

Ensure that the paper is the proper paper weight. 20 
lb (75 g/m2) bond paper is recommended.
Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam has been 
cleared.

Toner yield is lower than 
expected and TONER LOW 
message appears on the 
LCD.

Toner may be lodged in the cartridge. Remove the 
toner cartridge. Shake the toner cartridge and tap 
along the top of the toner cartridge over a waste 
receptacle. Take care not to touch the exposed toner 
on the left side of the cartridge.

Fewer copies from the toner 
cartridge than expected.

Your originals may contain pictures, solids, or heavy 
lines, for example, forms, newsletters, books or other 
documents that use more toner. The machine may be 
turned frequently on and off. The document cover is 
being left open while copies are being made.

The following message appears 
on your computer screen: 
Scanner is busy receiving or 
printing data. When the current 
job is completed, try again.

There may be a copying or printing job in progress. 
When the current job is completed, try the job again.

Condition Suggested solutions
TROUBLESHOOTING8.14
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Printing Problem Solution Chart

Condition Probable cause Suggested solutions

Your machine 
does not print.

The IEEE 1284 parallel 
cable or USB cable is 
not connected properly.

Check the cable connection.

The IEEE 1284 parallel 
cable or USB cable is 
defective.

Check the cable with a computer 
and printer that work. If printing is 
still not possible, replace the cable.

The port setting is 
incorrect.

Check the printer settings in the 
Windows Control Panel to make 
sure that the print job is being sent 
to the correct port. (For Example: 
LPT1.)

Your machine 
does not print. 
(continued) 

The toner and drum 
cartridges are not 
installed properly.

Check that the toner and drum 
cartridges are installed properly.

The printer driver may 
not be installed 
properly.

Reinstall the software.

The parallel port cable 
specifications may not 
be correct.

Use the IEEE 1284 parallel port 
cable supplied with the machine or 
replace it with an IEEE 1284 
compliant cable.

Half of the page is 
blank.

The page layout is too 
complex.

Reduce the resolution setting from 
600 dpi to 300 dpi. Install more 
RAM in the computer.

The page orientation 
may be incorrect.

Change the page orientation in the 
printer setup dialogue.
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When printing 
using the USB 
connection, an 
error occurs 
repeatedly.

When the USB mode is 
set to “FAST” some PC 
users may experience 
poor USB 
communication.

Change the USB mode to “SLOW.” 
To do so, take the following steps:

1. Press Menu/Exit then 
System Setup from the one-
touch dial keypad.

2. Use  or  until “USB MODE” 
appears on the top line of the 
display. The current setting 
appears on the bottom line.

3. Press  or  to select “SLOW.” 

4. Press Mode/Enter to save the 
selection.

5. Press Clear/Stop to return to 
Standby mode.

Printing is too 
slow.

The computer parallel 
port may not be set for 
high speed 
communications.

If your computer is equipped with 
an ECP parallel port, enable this 
mode of operation. Refer to the 
Enabling High Speed Printer 
Communications section and your 
computer’s user guide.

If using Windows 95, 
the spool setting may 
be set incorrectly.

Point to the Start and then click 
Settings then Printers. Click 
your printer icon with the right 
mouse button. Click Properties 
and then spool settings on the 
Details tab. Select the desired 
setting from the available choices.

Computer may not have 
enough memory (RAM). Install more RAM in your computer.

The print job is large. Reduce resolution from 600 dpi to 
300 dpi.

Condition Probable cause Suggested solutions
TROUBLESHOOTING8.16
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Irregular faded 
patches of print.

There is a paper quality 
problem.

Use only paper that meets the 
specifications required by the 
machine.

Toner may be unevenly 
distributed.

Remove the toner cartridge and 
shake it gently to evenly distribute 
the toner. Then reinstall the toner 
cartridge.

Black staining There is a paper quality 
problem.

Use only paper that meets the 
specifications required by your 
machine.

Character voids The paper may be too 
dry.

Try printing with a different batch 
of paper.

Background 
scatter

The paper may be too 
damp.

Try printing with a different batch 
of paper. Do not open packets of 
paper until necessary so that the 
paper does not absorb too much 
moisture from the air.

Printing over uneven 
surfaces.

If printing onto envelopes, change 
your printing layout to avoid 
printing over areas that have 
overlapping seams on the reverse 
side.

Missing characters The paper may be too 
damp.

Try printing with a different batch 
of paper. Do not open packets of 
paper until necessary so that the 
paper does not absorb too much 
moisture from the air.

Back of printout is 
dirty

The transfer roller may 
be dirty.

Print a few blank pages to clean 
the transfer roller.

Faded graphics Toner may be low.

Remove the toner cartridge and 
shake it gently to evenly distribute 
the toner. Then reinstall the toner 
cartridge.

Ensure that you have a spare toner 
cartridge.

Condition Probable cause Suggested solutions
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Fax Problem Solution Chart

Condition Suggested solutions

The machine is not 
working, there is no 
display and the buttons 
are not working.

Unplug the power cord and plug it in again. 

Check that your socket is Live.

No dial tone

Check that the phone line is connected properly.

Check that the phone socket on the wall is working by 
plugging in another phone.

The numbers stored in 
the memory do not dial 
correctly.

Make sure that the numbers are stored in the memory 
correctly. Print a Phone Book list referring to the 
Facsimile Reference.

The document does not 
feed into the machine.

Make sure that the document is not wrinkled and you 
are putting it in correctly. Check that the document is 
the right size, not too thick or thin. 

Make sure that the ADF top cover is firmly closed.

Faxes are not received 
automatically.

The FAX mode should be selected. 

Make sure that there is paper in the Tray.

Check if the display shows “MEMORY FULL.”

Faxes are not received 
manually.

Check that you hung up the handset of the external 
telephone before you started faxing.

Your machine will not 
send anything.

Make sure that the document is loaded face down/up 
depending on whether you are using the Document 
scanner glass or ADF unit. 

“TX” should show up on the display. 

Check the other fax machine you are sending to, to see 
if it can receive your fax.

You cannot poll another 
machine.

The fax machine you are polling may be using a poll 
code. Contact the remote operator.
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The incoming fax has 
blank spaces or you 
received a poor-quality 
copy.

The fax machine sending you the fax may be faulty. 

The fax machine sending you a fax may have a dirty 
document glass. Clean the document glass, referring to 
page 7.2. 

A noisy phone line can cause line errors. 

Check your machine by making a copy. 

The toner cartridge may be empty. Replace the toner 
cartridge, referring to page 7.3. 

Some of the words are 
stretched on the 
incoming fax.

The fax machine sending you the fax had a temporary 
document jam. 

There are lines on the 
copies or documents you 
send.

Check your scan glass for marks, and clean it. See 
page 7.2.

The machine dials a 
number, but fails to 
make a connection with 
another fax machine.

The other fax machine may be turned off, out of paper, 
or cannot answer incoming calls. Speak with the other 
machine operator and ask her or him to sort out the 
problem.

Documents are not 
stored in the memory 

There may not be enough memory to store the 
document. If the display shows a “MEMORY FULL” 
message, delete any documents you no longer need 
from the memory, then restore the document.

Blank areas appear at 
the bottom of each page 
or on other pages, with 
only a small strip of text 
printed at the top.

You may have chosen the wrong paper settings in the 
user option setting. Refer to the Facsimile Reference to 
choose the proper paper size.

Condition Suggested solutions
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A
 SPECIFICATIONS
This chapter includes:

• General Specifications

• Scanner and Copy Specifications

• Printer Specifications

• Facsimile Specifications



General Specifications

Item Description

Printing method Laser scanning unit

Scanning method Sheet-fed and Flat-bed CCD(charge coupled device) 
module 

Effective scanning width 8.2 inches (208 mm)

ADF Document size

Width    6.9 to 8.5 inches (174 to 216 mm)

Length  Single page: 5 to 59 inches (128 to 1500 mm)

            Multi pages: 5 to 14 inches (128 to 356 mm)

Recording paper type

for Tray : Letter, A4, Legal 

(weight: 60~90 g/m2, 16 ~ 24 lb)

for Bypass Tray: Letter, Legal, JIS B5, A4, Executive, A5, 
A6 card, Post Card 4x6, HagaKi, Envelope 7-3/4, 
Envelope COM-10, Envolope DL, Envelope C5

* Min.: 3.9 x 5.8 inches (98 x 148 mm), 
   (weight: 60~120 g/m2, 16 ~ 32 lb)

Recording paper capacity
for Tray : 550 sheets (weight: 75 g/m2, 20 lb)

for Bypass Tray: 100 sheets (weight: 75 g/m2, 20 lb)

Automatic document 
feeder Up to 30 pages (20 lb or 75 g/m2)

Consumables 2-piece Toner/Drum cartridge system

PC Interface IEEE 1284 Parallel, USB 1.1

Compatibility Win 95, 98, 2000, NT 4.0, Win Me, Win XP

Power requirements 100 ~ 127 VAC, 50/60 Hz, 5A

Power consumption

Sleep mode: 35 W

Standby mode: 90 W

Average: 350 W

Operating  conditions
Temperature: 50 oF to 89 oF (10 oC to 32 oC)

Humidity: 20% to 80% RH

LCD 16 Characters x 2 lines

Toner cartridge life 6,000 pages (for starter, 3,000 pages) @ IDC 5% coverage

Drum cartridge life 15,000 pages @ IDC 5% coverage
SPECIFICATIONSA.2
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Scanner and Copy Specifications

Printer Specifications

SET Dimension (WxDxH) 22.0 x 17.0 x 18.1 inches (560 x 433 x 459 mm)

Weight Net: 22.5 Kg (including consumables)

Package Weight
Paper: 2.7 Kg

Plastic: 0.7 Kg

Item Description

Item Description

Compatibility TWAIN standard

Resolution Optical 600 dpi resolution (Mono and Color)

Color bit depth
Internal: 32 bit

External: 24 bit

Mono bit depth
1 bit for text mode

8 bit for Gray mode

Copy speed
15 copies per minute/A4

16 copies per minute/Letter

Copy resolution 1,200 dpi enhanced

Zoom Rate
by platen   25 ~ 400 %

by ADF    25 ~ 100 %

Item Description

Printing method Laser Scanning Unit + Electro Photographic

Printing speed
15 copies per minute/A4

16 copies per minute/Letter

Print resolution 1200 dpi class

Emulation language PCL 6
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Facsimile Specifications

Item Description

Printing method Laser Scanning Unit

Compatibility ITU-T Group 3, ECM

Applicable line Public Switched Telephone Network(PSTN) or behind 
PABX

Data coding MH/MR/MMR (ECM Mode) and JPEG for color fax 
transmission

Modem speed 33600/28800/21600/19200/14400/12000/9600/7200/
4800/2400 bps with fall back

Transmission speed

Approx. 3 seconds/page

* Transmission time applies to memory transmission of 
text data with ECM compression using only ITU-T No.1 
Chart.

Scanning speed

Platen: approx. 3 seconds/letter (at standard fax 
resolution mode)

ADF: approx. 5 seconds/letter (at standard fax resolution 
mode)

Resolution
Standard(203x98 dpi), Fine(203x196 dpi), 
Superfine(300x300 dpi), Photo(203x196 dpi/300x300 
dpi), Color(203x196 dpi)

User Memory 4 MB (320 pages)

Halftone 256 levels

Auto dialer
One-touch dialling (registration for 40 numbers)

Speed dialling (registration for 80 numbers)
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INDEX

A
ADF load 4.3

C
cartridge locking lever 1.14
clone

in copy mode 4.10
collation for copying 4.12
contrast

for copying 4.7
copy size 4.8

D
default printer 5.2
display language 1.19
document

jam, clear 8.2
load in ADF 4.3
load on document glass 4.4

document glass
clean 7.2
load 4.4

drum
clean 7.8
install 1.12
replace 7.8

E
error 8.11
extension phone, connect 1.10

F
fit to page

print 5.8
fit to page print

in copy mode 4.9

G
graphic properties, set 5.17

J
jam, clear

document 8.2
paper 8.4

L
Loading Paper in the Tray 3.1

N
network printer, set 5.20
n-up (multiple pages per sheet)

print 5.6



O
overlay, use 5.13

P
paper jame, clear 8.4
paper load

in Bypass tray 3.6
in Tray 1.15

paper load capacity 3.2
paper save 1.20
paper size, set

in Bypass tray 3.9
paper source

in copy mode 4.2
in print mode 5.5

paper type 3.2
parallel, connect 1.11
poster

print 5.9
power save 1.20
print resolution 5.17
printer driver

install 2.4
printer driver window 5.3
printing

fitting to a selected paper size 5.8
multiple pages on one sheet 5.6
posters 5.9
reduced or enlarged document 5.7
using overlays 5.13
watermarks 5.10

R
reduced/enlarged

print 5.7

S
Safety information 1.vi
scanner lock 1.2
software

install 2.4

T
tel line, connect 1.9
toner cartridge

install 1.12
life 7.3
replace 7.5

two-sided print
in copy mode 4.11

Type 102 driver
install 2.4

U
USB, connect 1.10
Using the Bypass Tray 3.1

W
watermarks, use 5.10
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